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Chapter 1: Getting Started

The Abila Millennium Installation Guide includes combined instructions for both new installations and
upgrade installations of AbilaMillennium. Themost current version of this guide is available for
download from the Abila Knowledgebase or from theMillenniumproduct page.

Chapter Overview
Chapter 1: Getting Started—This chapter describes the AbilaMillennium components, system
requirements, and theHelp system.

Chapter 2: Installing the Web Server (IIS) and Database Server—Preliminary tasks,
considerations and instructions for installing and upgrading theWeb Server (IIS) and Database Server.

Chapter 3: Installing the Reporting Server—Tasks, considerations and instructions for installing
and upgrading the Reporting Server component of AbilaMillennium.

Chapter 4: Configuring Workstations for Millennium—Configuration settings for workstations
andmobile devices that will access AbilaMillennium.

Chapter 5: Display and System Settings—Additional Display Options, SystemOptions, and System
Information settings to perform in AbilaMillennium software after theWeb Server (IIS), Database
Server, and Reporting Server components have been installed and configured. Also includes the
passwords for the File Search, Log Off User, Merge ID, and User Dump utilities.

Appendix Overview
Appendix A: IIS Services and Features—Use the information in this section to verify that the
appropriate roles and features

Appendix B: Creating the Web SQL ODBC Connection to your Database—Instructions for
creating theWeb SQL ODBC connection to your database; instructions are for both SQL Server and
Oracle platforms.

Appendix C: Abila Millennium and SMTP—About SimpleMail Transfer Protocol (SMTP) in relation
to AbilaMillennium.

Appendix D: Installing and Running the Queue—Includes information about running the
reporting Queue as aWindows Service, or running theQueue as an application.

Abila Millennium
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Appendix E: Defining Printers—Includes information about using the Printers utility (Printers.exe)
to define AbilaMillenniumprinters.

Appendix F: Installing the Sample Database—Includes instructions and considerations for
installing the AbilaMillennium sample database.

Appendix G: Database Changes—Contains the database changes for recent releases of Abila
Millennium.

Abila Millennium Components
When you install AbilaMillennium, you will be setting up the following components.

Web Server (IIS)—TheWeb Server (IIS) component provides content to the client workstations.
After you install the AbilaMillennium files, you need to configure theWeb Server (IIS) to run and
serve the content correctly.

Database Server—TheDatabase Server hosts the AbilaMillenniumdatabase.

Reporting Server—The Reporting Server enables you to generate the reports you need. This
server can access data in your production AbilaMillenniumdatabase, or you can replicate that data
to another database and this server can access the replicated database. In some smaller
configurations, you can install and run the Reporting Server andWeb Server (IIS) on the same
machine.

Client Workstation—You can access AbilaMillennium from any computer with a supported
browser.

Note:
Support for the Abila Auto Update utility has been removed fromMillennium. You will no longer
receive updates about Millennium from this utility. However, the installation process will not
uninstall the Abila Auto Update. If you have no other Abila products, you can remove the utility
from theMillennium server by using theWindows Control Panel.

System Requirements
Systemperformance is affected by a variety of factors including hardware, network configuration,
database size, number of concurrent users, and competition for resources by other programs. The
latest AbilaMillennium system requirements are available at
http://www.abila.com/solutions/millennium.

http://www.abila.com/solutions/fundraisingcrm/millennium/


The Help System

These requirements can be scaled up depending on the size and complexity of your data and
processing requirements. You shouldmeet or exceed these system requirements for AbilaMillennium.

Important! Windows XP and SQL Server 2005 are no longer supported .

Notes:
Microsoft Internet Explorer 11.0 is required forMillenniumVersion 2017.1. Earlier versions of
Microsoft Internet Explorer will not work with theMillenniumReporter. In addition, Compatibility View
must be turned off. See "Remove Compatibility View" (page 42) formore information.

The Help System
The AbilaMillenniumonline help provides an easy way to get help when you need it. There is a wealth of
information available that you can use daily to help you in your work. By exploring and reviewing online
help, you learn to use the systemquickly, effectively, and efficiently.

Once you have successfully logged on to the system, the AbilaMillennium Explorer displays in a narrow
pane to the left of the display pane (the display pane is the larger one to the right). When the Abila
Millennium Explorer is first shown, each Explorer item is listed with a small graphic. TheHelp item gives
you access to the AbilaMillenniumHelp system aswell as other informative fund-raising topics. Expand
theHelp Explorer item, and select Help Contents. AbilaMillenniumHelp Contents opens in a new
browser window or tab. Click a topic link, or use theContents, Index, and Search components (in the
Help system's navigation pane) to find and display the information you need.

The navigation toolbar (across the top) contains several controls. If you point to each control, a tip will
tell you what the control does. Once you have located and displayed a topic, useQuick Search to help

pinpoint the information that you want. Return toHelp Contents at any time by clickingHome . As

youmove fromone topic to the next, the navigation toolbar and the navigation panewill persist.

However, you can click theNavigation button to hide the navigation pane, and click that button

again when you want to re-display the navigation pane.

Help can also be accessed fromdata display pages by pointing to any Edit button and clickingHelp.
The topic related to the area of the system in which you areworking opens in a new browser window or
tab. For example, if you are entering a new Proposal for a constituent, then the Proposal topic will be
shown. The topic includes theOpen topic with navigation link at the top of the page. Click this link if
you want to display the topic with theHelp system's Navigation pane and Navigation toolbar.

Help can also be accessed when performing system-related tasks. This includes setting SystemOptions
and System Information. Click theHelp button to display the topic (or section within the topic) that

Abila Millennium
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relates to the system task that you are performing. The topic will open in a new browser window or
tab, and also include theOpen Topic with navigation link.



Chapter 2: Installing the Web Server (IIS) and
Database Server

This chapter discusses the installation of theWeb Server (IIS) component of the AbilaMillennium
system. Installing theWeb Server (IIS) involves performing the following tasks. Each task will have its
own set of steps to complete and concepts to consider.

Preparing to install AbilaMillenniumon theWeb Server (IIS) computer.

Preparing the AbilaMillenniumdatabase for conversion to version 2017.1.

Running the Installation program to install the necessary files on to theWeb Server (IIS). You will also
have the option to have the installation program convert your database to version 2017.1.

Creating the Anonymous Access User and QueueUser accounts.

Configuring theWeb Server (IIS) and related files so that AbilaMillennium runs in your environment,
and so that you can access other AbilaMillennium components.

Manually convert your AbilaMillenniumdatabase to version 2017.1. Follow these steps if errors
were encountered during the database conversion process, or if you did not choose to have the
installation programdo the database conversion program for you.

Considerations for upgrading SQL Server organizations that maintain custom views for Abila
Millenniumdata entry purposes.

Once you have completed the tasks that are detailed in this chapter, proceed to install the Reporting
Server (Chapter 3: Installing the Reporting Server), configure individual workstations so that Abila
Millennium can be accessed by your users (Chapter 4: ConfiguringWorkstations forMillennium), and
then complete the additional display and system configuration tasks that are outlined in Chapter 5:
Display and System Settings.

Preparing to Install the Web Server component on the IIS Server

Before installing the Web Server component of Abila Millennium, complete the following:

1. Verify that the target MillenniumWeb Server (IIS) meets or exceeds the current system
requirements. The latest AbilaMillennium system requirements are available at
http://www.abila.com/solutions/fundraisingcrm/millennium/system-requirements/.

Abila Millennium
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2. Verify that you have themost current version of this guide. The current version is available for
download at http://kb.abila.com.

3. Back up theWeb Server (IIS) computer so that the system can be restored.

4. Verify that the IIS roles and features are correctly installed on theweb server. This includes the
Web Server (IIS) Role and the applicable (to your server) ASP.NET Application Development
feature. See"IIS Services and Features" (page 52) for a complete list of necessary roles and
features.

a. Open the IISManager (Start>Server Manager>IIS).

b. Scroll to theRoles and Features section, and compare the installed features with the list in
"IIS Services and Features" (page 52).

c. Install any missing roles or features by using the Add Roles and Features wizard or by using
Windows PowerShell commands.

5. Upgrading organizations, youmust be running AbilaMillennium version 2014.1, 2015.1, or
2016.1. You cannot upgrade directly from a version that is earlier than version 2014.1.

If you are on version 2013 or earlier, youmust incrementally upgrade yourWeb Server (IIS) and
convert your database through all of themajor versions that were released after your version, up
to and including version 2014.1. For example, if your AbilaMillennium version is 7.9, install
version 2013 and version 2014.1 before installing 2017.1.

6. Upgrading organizations, if you do not own a Sage product, you can uninstall Sage Advisor
Update from the IIS computer.

Note: Sage E-marketing and Sage Payment Solutions are two examples of Sage products that
youmay currently own. If you own at least one Sage product, then do not remove Sage Advisor
Update.

7. ForOnline Constituent Directory (OCD) organizations that are upgrading: back up the custom
OCD templates (to another location) before installing the upgrade..

These templates are located in the \inetpub\wwwroot\mill\ecomm directory.

8. For the organizations that use custom report templates (.txt files) and are upgrading: back up the
custom report templates (to another location) before installing the upgrade.

These templates are located in the \inetpub\wwwroot\mill\java\customtemplate directory.

9. For the organizations that use Site-Specific Help procedures and are upgrading: back up Site-

http://kb.abila.com/
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Specific Procedures (to another location) before installing the upgrade.

Site-Specific Help procedures are help html files that begin with SSP or ssp, and are located in the
\inetpub\wwwroot\mill\help directory.

10. Crystal Reporting software (used by report writers at your organization) cannot be installed on the
Web Server (IIS) computer.

If Crystal Reporting software is currently installed, remove it before installing AbilaMillennium. See
KB article 1086 for information about Crystal compatibility.

11. Review the database engine settings in theDatabase Engine Settings section below. Configure your
settings accordingly.

12. Review the considerations and complete the steps in the Preparing to Convert the Database section
of this chapter.

Database Engine Settings

Microsoft SQL Server

1. The collation on themilldata andmillreports databasemust match, and we recommend using
Latin 1_ General_BIN. However, if themaster and tempdb databases have a collation other than
Latin 1_ General_BIN, youmay need to select a different collation. To eliminate collation issues
when joining on chapter columns between databases, themilldata,millreports,master, and
tempdb databases should have the same collation. Regardless of character set, use aBIN (binary)
sort.

2. Set the compatibility level on themilldata andmillreports databases to the level that corresponds
to your SQL Server version.

a. Open SQL ServerManagement Studio.

b. Right-click on the name of the AbilaMillennium (milldata) database and select Properties.

c. Select theOptions tab. Verify theCompatibility Level is set to the correct level.

d. Repeat Steps 2b and 2c for themillreports database.

3. TheAuto ShrinkMicrosoft SQL Server database option can degrade performance and cause Abila
Millenniumutilities and reports to stop running. DisableAuto Shrink on the AbilaMillennium
database (milldata) andmanage the database sizemanually.

Abila Millennium
Installation Guide
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a. Open SQL ServerManagement Studio.

b. Right-click on the name of the AbilaMillennium (milldata) database and select Properties.

c. Click theOptions page.

d. UnderAutomatic, set Auto Shrink to False.

Oracle

The recommended NLS_CHARACTERSET isWE8MSWIN1252 to support the special characters that are
used by the application.

Preparing to Convert the Database
1. If you are installing AbilaMillennium for the first time, youmust identify or create the database for

the application to use.

2. Create theWeb SQL ODBC connections at theWeb Server (IIS) computer. Upgrading organizations
may only need to verify that the correct Web SQL ODBC connections are present. If necessary,
refer to Appendix B: Creating theWeb SQL ODBC Connection to your Database for procedures.

3. If you are upgradingMillennium, review the following tasks and considerations to prepare your
database for conversion:

a. Back up the data database (milldata).

b. For SQL Server organizations, back up yourmillreports database.

c. The {transaction number + create user} combination is used when linking secondary data to
the gifts/dues row. Duplicate {transaction number + create user} combinations can cause data
integrity issues when linking secondary data. During the upgrade database conversion process,
theGift table andDues table will be checked for duplicate {transaction number + create user}
combinations. An errormessagewill tell you if your tables contain duplicates, and a table of
duplicates will be created in your AbilaMillenniumdatabase. Manually correct your duplicate
entries by making the {transaction number + create user} combination unique, and delete any
incorrectly linked secondary data.

d. If you are upgradingMillennium, the database conversion adds the following system-required
entries into the report_groups andmemory_names lookup tables. If drivX (where X is any
value, or blank) codes already exist in your report_groups lookup table, or the abila1, abila2,
abila3, or abila4 codes already exist in yourmemory_names lookup table, manually change
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your codes before you upgrade or certain MillenniumDrive features will not function properly. If
you already have the same values as our standard values for abila1, abila2, abila3 and abila4,
you can change our standard values after you upgrade.

Lookup Table Code Value

report_groups driv Drive

Note: Reports that are saved into this report
group and published in PDF or HTML format can
be viewed inMillenniumDrive.

memory_names abila1 Total Giving

abila2 Consecutive Years Giving

abila3 Largest Gift

abila4 Total Giving Year to Date

e. If you are upgrading from version 2014.0.x, the database conversion adds three standard
numeric Summary utility definitions and a standard Years utility definition that use the abila1,
abila2, abila3 and abila4 memory names.These definitions will be used when running the new
Consecutive Years Giving Abila2, Largest Gift Abila3, Total Giving Abila1, and Total
Giving Year to Date Abila4 Financial reports. These new Financial reports run the Summaries
utility or the Years utility to create records in the Summaries data table that will display in
MillenniumDrive.

Organizations can have only one Years Utility definition. If you already have one, the database
conversion programwill not overwrite it.

Note: If you have an existing Years Utility definition, and you want Consecutive Years Giving to
display in MillenniumDrive, then you will need to either edit your definition for Consecutive
Years (after the upgrade) to use the abila2/Consecutive Years Givingmemory name, or
customize theMillenniumDrive Summary page to display your Consecutive Years
definition.

f. The database conversion adds any updates required for the upgrade. Therewere no specific
database changes for version 2016.1. For information about previous changes, see Appendix G:
Database Changes

Abila Millennium
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Installing the Web Server (IIS) Files
TheWeb Server (IIS) installation program allows you to install or upgrade AbilaMillenniumon theWeb
Server (IIS) computer.

1. Complete the steps that are listed under the Preparing to Install Abila Millennium on the Web
Server (IIS) section of this chapter (above).

2. Review the considerations and complete the steps that are listed under the Preparing to Convert
the Database section of this chapter (above).

3. At the Web Server (IIS) computer, log on as a site administrator with administrative privileges on the
computer and with full access to all directories in \inetpub\wwwroot\mill.

4. Double-click on the self-extracting zip file. Enter the path and name of the directory into which to
extract the installation files, or accept the default. The directory path and name cannot contain
spaces. If they do, then an Error during executionmessage is displayed.

5. If the installation programdoes not start automatically, browse to the directory into which the
installation files were extracted and click AutoRun.exe.

6. When the installation programbegins, click Install Millennium Web Server.

7. The installation program checks for components that are needed on the computer before the IIS
Server can be installed. If one ormore of the following items aremissing, the installation program
will display the install requirements page.

Microsoft .NET Framework 4.5 Full

Microsoft Visual C++ 2012 Redistributable Package update 4 (x86)

Crystal Reports 2008 SP4 run time components

8. Click Install to install the prerequisite components.

9. On thewelcome page, clickNext to proceed.

10. TheCustomer Information page is shown only if you are installing AbilaMillennium for the first
time. Type the Serial Number and Registration Number that was provided to your
organization. ClickNext.

If you are upgrading, the installation programwill not show theCustomer Information page to
prompt you for your registration information.
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11. On theDestination Folder page, indicate the location where AbilaMillenniumwill be installed. You
can accept the default location or click Change to specify a different one. ClickNext.

12. On the Install Options page, select the database engine option that applies to your organization
and check the Start upgrade of your database to 2017.1 at end of installation box if you
want to automatically launch the conversion of the database to version 2017.1 after the installation
program completes. ClickNext.

If you do not select this check box, then youmust manually convert your database after installing
theWeb Server (IIS).

13. On theReady to Install the Program page, click Install.

14. The systemmight display a pop-upmessage that asks if you want to uninstall Crystal reports
2008 runtime. ClickNo to prevent the upgrade process from removing existing Crystal runtime
reports from the system.

15. When the installation is complete, the InstallShield Wizard Completed page displays to indicate
that theWeb Server (IIS) was successfully installed. Click Finish.

16. The database conversion programwill launch automatically if you selected the Start upgrade of
your database to 2017.1 at the end of installation option. Follow the steps appropriate for
your database engine inManually Converting the Abila Millennium Database, beginning with Step 2.
Formore information about recent database changes, see Appendix G: Database Changes.

If database conversion errors occur:

Database conversion errors arewritten to a log file. Review
X:\inetpub\wwwroot\mill\tools\log\conv2017_1.log for errors.

Correct errors as necessary.

Run conv2017_1.exe (the database conversion program) from the
X:\inetpub\wwwroot\mill\tools directory.

17. Review the considerations in theUser Accounts section of this chapter and create the Anonymous
Access User and QueueUser accounts as needed.

Note: Creating theQueueUser accounts is an optional step at this point in the installation
process.

18. Perform theWeb Server (IIS) configuration tasks to complete the installation and configuration
process. Steps are provided in Configuring the Web Server (IIS).

Abila Millennium
Installation Guide
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User Accounts

Anonymous Access User

The IIS Server and all Reporting Server computersmust have a common user account to use as the
Anonymous Access User. Use a domain account, or a local user account that can be recreated on the
Reporting Server computers. An account that is recreated on Reporting Server computersmust have
the identical user name and password as the account on the IIS Server.

Youmust use a customdomain or user account as the Anonymous Access User if your system is
distributed over different computers. You cannot use the IIS IUSR built-in account because the
password on the built-in IIS user account cannot be set, so the account cannot be recreated on
another computer.

Create a customAnonymous Access User or identify an existing domain or local user account to use
for Anonymous Access.

Queue User

TheQueueUser is the user who runs theQueue on the Reporting Server. A user account must exist
on the Reporting Server for theQueueUser. An identical user account must also exist on theWeb
Server (IIS) computer for every QueueUser at your organization.

If the Queue runs as an application: theQueueUser is the user who logs on to the Reporting
Server computer. Identify theQueueUser for each Reporting Server computer that is used by your
organization. Verify that each QueueUser has an identical account on theWeb Server (IIS) computer.
If not, then create one. The user name and password on theWeb Server (IIS) computermust be
identical to theQueueUser name and password on the Reporting Server computer.

If theQueue runs as an application, you can identify theQueueUsers when you install theWeb Server
(IIS), or you can identify your QueueUsers when the Reporting Server is installed, and then return to
theWeb Server (IIS) computer to apply the necessary shares and permissions for theQueueUsers.

If the Queue runs as a service: theQueue is installed as a service after the Reporting Server is
installed. The program that is used to install theQueue as a service can create theQueueUser on the
Reporting Server and onWeb Server (IIS) computers at that time.

If you install theQueue as a service, then youmust return to theWeb Server (IIS) computer to apply
the necessary shares and permissions for theQueueUser.

Formore information about theQueue, review Appendix D: Installing and Running the Queue.
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Configuring the Web Server (IIS)
The following steps configure the settings that are necessary for successful AbilaMillennium
operations. They apply to both new organizations and to organizations that are upgrading. For
upgrading organizations, some of these stepsmay not be necessary to perform, but it is important to
review all steps in order to insure that your settings are correct. These steps are performed at theWeb
Server (IIS) computer.

1. Access the Internet Information Services (IIS) Manager by navigating to Start>Control
Panel>Administrative Tools>Internet Information Services (IIS) Manager. Run as
administrator.

2. Upgrading organizations (from version 2013 only)—Remove theMillsecure ISAPI filter at the
Default Web Site level:

a. On theConnections pane, go to Sites>Default Web Site>Features View tab.

b. In the Features list section, under IIS, click ISAPI Filters.

c. On theActions pane, clickOpen Feature.

d. In the Filters list, clickMillsecure.

e. On theActions pane, click Remove.

3. Upgrading organizations (from version 2013 only)—If theMillsecure ISAPI filter exists at the
Server level, remove it:

a. On theConnections pane, expand (if necessary) the name of the server. Select the Features
View tab at the bottomof the center pane (if necessary).

b. In the Features list section, under IIS, click ISAPI Filters.

c. On theActions pane, clickOpen Feature.

d. In the Filters list, clickMillsecure.

e. On theActions pane, click Remove.

4. Set the Feature Delegation for Handler Mappings and for Modules to Read/Write at the
server level.

a. Select the Features View tab at the bottomof the center pane (if necessary).

b. In the Features View section, underManagement, double-click Feature Delegation.

Abila Millennium
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c. To set the Feature Delegation for HandlerMappings and forModules at the Default Web Site
level only, on theActions pane, click Custom Site Delegation.

d. Select Handler Mappings on the delegation list. On theActions pane, click Read/Write.

e. SelectModules. On theActions pane, click Read/Write.

5. The installation program added the Application Pool for AbilaMillennium, and named it
MillAppPool. Set theMillAppPool Identity to the Anonymous Access User and configure other
settings forMillAppPool:

a. On theConnections pane, expand (if necessary) the name of the server.

b. Click Application Pools.

c. In the center pane, clickMillAppPool.

d. On theActions pane, click Advanced Settings.

e. In the Process Model section, set Identity to the Anonymous Access User.

i. Click Identity.

ii. Click the ellipsis button.

iii. Select theCustom account option.

iv. Click Set.

v. On the Set Credentials dialog, type in the Anonymous Access UserUser name,
Password (and Confirm password), and clickOK.

vi. On theApplication Pool Identity dialog, clickOK.

f. In the (General) section, set Start Mode to AlwaysRunning if usingWindows Server 2012.

g. If you are running on a 64-bit operating system, in the (General) section, set Enable 32-Bit
Applications to True.

h. ClickOK.

6. At the Default Web Site level, verify that the Status for Anonymous Authentication is set to
Enabled and set theAnonymous Authentication Credentials to the Anonymous Access User.
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a. On theConnections pane, expand Sites.

b. Click Default Web Site. Select the Features View tab at the bottomof the center pane (if
necessary).

c. In the Features View section, under IIS, double-click Authentication.

d. Click Anonymous Authentication.

e. If the Status for Anonymous Authentication is not set to Enabled on theActions page, click
Enable.

f. On theActions pane, click Edit. 

g. Select the Specific user option.

h. Click Set.

i. On the Set Credentials dialog, type in the Anonymous Access UserUser name, Password
(and Confirm password), and clickOK.

7. Restart the IIS.

a. On theActions pane, underManage Web Site, click Restart.

8. Verify that theWorldWideWeb Publishing Service is running. If you will be utilizing theMillennium
Assignment Service, verify that the Assignment Service is running.

a. Start>Control Panel>Administrative Tools.

b. Double-click Services.

c. In the Services list, locateWorld Wide Web Publishing Service (andMillennium
Assignment Service, if wanted). Verify that the service status is Running. If not, right-click the
service and click Start.

9. Enable "Log on Locally" rights for the Anonymous Access User (MillAppPool Identity).

a. Start>Control Panel>Administrative Tools>Local Security Policy. Run as administrator.

b. On the Security Settings pane, expand Local Policies. Click User Rights Assignments.

c. Double-click theAllow log on locally (or Log on locally) security setting. Add the Anonymous
Access User, and clickOK.

Abila Millennium
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10. Use Table 1: IIS Server Security and Share Permissions to share directories and to grant
directory security and share permissions. Be aware that at the time you install or upgrade Abila
Millennium, it is possible that not all QueueUser accounts exist on the IIS Server computer. After
you install a Reporting Server, youmight need to return to the IIS Server to set these directory
share and security permissions for theQueueUser.

Directory Share? Security
Permissions

Share
Permissions

\inetpub\wwwroot\mill\bits No Anonymous
Access User
(MillAppPool
Identity) - Full
Control

\inetpub\wwwroot\mill\de No Anonymous
Access User
(MillAppPool
Identity) - Full
Control

\inetpub\wwwroot\mill\Docs

(or the virtual directory containing the
Docs folder, if you are not using the
default location

Yes Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser - Full
Control

All Users who will
be attaching
documents to
data rows
(attachments) -
Write

Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser -
Full Control

Table 1: IIS Server Security and Share Permissions
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Directory Share? Security
Permissions

Share
Permissions

\inetpub\wwwroot\mill\Exports Yes Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser - Full
Control

Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser -
Full Control

\inetpub\wwwroot\mill\Formats (SQL) or

\inetpub\wwwroot\mill\OracleFormats
(Oracle)

Yes Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser - Full
Control

All Users who will
be creating and
editing report
formats - Full
Control

Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser -
Full Control

All Users who
will be creating
and editing
report formats -
Full Control

\inetpub\wwwroot\mill\reports Yes Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser - Full
Control

Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser -
Full Control

Table 1: IIS Server Security and Share Permissions (continued)
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Directory Share? Security
Permissions

Share
Permissions

\inetpub\wwwroot\mill\reports\import No Anonymous
Access User
(MillAppPool
Identity) - Full
Control

\inetpub\wwwroot\mill\tools\log No Anonymous
Access User
(MillAppPool
Identity) - Full
Control

\inetpub\wwwroot\mill\tools\WebReports No Anonymous
Access User
(MillAppPool
Identity) - Full
Control

\windows\temp No Anonymous
Access User
(MillAppPool
Identity) - Full
Control

QueueUser - Full
Control

\inetpub\mailroot

(only if using SMTP with AbilaMillennium)

No Anonymous
Access User
(MillAppPool
Identity) -Write

Table 1: IIS Server Security and Share Permissions (continued)

11. For Oracle organizations - grant the Anonymous Access User (MillAppPool Identity) Read &
Execute, List Folder Contents, and Read on the Security tab of the directory in which theOracle
client tools are installed.
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12. At the root for the JSI FundRaising Systems, Inc. registry key, grant Full Control permissions to
the Anonymous Access User (MillAppPool Identity).

a. Access the Registry Editor:

i. Access the Run command by pressing theWindows logo key + R.

ii. In theOpen box, type regedt32, and clickOK.

b. Navigate toHKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node.

c. Right-click on JSI FundRaising Systems, Inc. and click Permissions.

d. UnderGroup or user names, select the Anonymous Access User (MillAppPool Identity) name.

e. Under Permissions for <name of user>, select theAllow check box for Full Control

f. ClickOK.

13. The SMTP Servicemust be installed and running on theWeb Server (IIS) in order to utilize the
Assignments e-mail Notifications feature. And, if your organization uses theOnline Constituent
Directory, SMTP Servicemust be installed and running in order to send log on credentials to the
constituents who forget user names and/or passwords. SMTP is installed and configured by your
organization's IT Department.

a. You will need to inform them that it must be installed to X:\inetpub\mailroot in order for it to
work with AbilaMillennium.

b.  At theWeb Server (IIS), verify that the SMTP Service is started.

i. Start>Control Panel>Administrative Tools.

ii. Double-click Services.

iii. In the Services list, locate Simple Mail Transfer Protocol (SMTP). Verify that the service is
Running. If not, right-click the service name and select Start.

c. Review additional Setup, Configuration, and Testing considerations in Appendix C: Abila
Millennium and SMTP.

14. SSL must be implemented for both AbilaMillennium andMillenniumDrive.

When SSL is enabled, Java controls are not used when users log on to AbilaMillennium. One benefit
is that iPad users can access the full Millennium interface.
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Manually Converting the Abila Millennium Database
conv2017_1.exe is the utility that converts your database to AbilaMillennium 2017.1. You will run
the conversion utility if you did not convert your databasewhile installing theWeb Server (IIS). You
will also run conv2017_1.exe if database conversion errors occurred when installing theWeb Server
(IIS).

To manually convert your SQL Server database:

1. Navigate to \inetpub\wwwroot\mill\tools and double-click conv2017_1.exe.

2. Select theMS SQL Server Destination Type.

3. Type the Filegroup forData and Index or leave as default.

4. Choose your error handling option.

Select the Print to Log File option for unattended execution.

Select theRaise a message box option if you wish to intervene if an error occurs. Errors will
also bewritten to a log file if you select theRaise a message box option.

5. Click File>Start.

6. On the Select Data Source dialog, click theMachine Data Source tab and select theWeb SQL
ODBC connection.

7. On the SQL Server Login dialog, clickOptions to verify the database information.

8. Type sa in the Login ID box, and enter your password in the Password box.

9. ClickOK. The conversion begins and the status bar displays the conversion progress.

10. If there are conversion errors, finish the installation and then review the error log file created in
the \inetpub\wwwroot\mill\tools\log directory. Make data corrections as needed and then re-
run the conv2017_1.exe file.

11. When the conversion has completed, clickOK.

To manually convert your Oracle database:

1. Navigate to \inetpub\wwwroot\mill\tools and double-click conv2017_1.exe.

2. ChooseOracle as the destination type.

3. Fill in the Tablespace forData and Index.
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4. Choose your error handling option.

Select the Print to Log File option for unattended execution.

Select theRaise a message box option if you wish to 'intervene' if an error occurs. Errors will
also bewritten to a log file if you select theRaise a message box option.

5. Click File>Start.

6. On the Select Data Source dialog, click theMachine Data Source tab and select theWeb SQL
ODBC connection.

7. On theOracle ODBC Driver Connect dialog, verify the Service Name is correct.

8. TypeMILLORA in theUser Name box, and enter your password in the Password box.

9. ClickOK. The conversion begins and the status bar displays the conversion progress.

10. If you receive conversion errors, finish the installation and then review the error log file created in
the \inetpub\wwwroot\mill\tools\log directory. Make data corrections as needed and then re-
run the conv2017_1.exe file.

11. When the conversion has completed, clickOK.

Custom Views
This section applies only to upgrading SQL Server organizations who use custom views for Abila
Millennium data entry. If you are not upgrading, or If you are an Oracle organization, or if you do not
use custom views for data entry, then skip this section.

New columns are not added to custom viewswhen the database conversion program refreshes
database views. Therefore, if you have custom views that are not in the form of 'select * from' on a
AbilaMillenniumdata table to which new columns have been added, youmust manually add the
columns to these views after the database has been converted. Formore information about database
changes, see Appendix G: Database Changes.
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Installing the Reporting Server component of AbilaMillennium involves performing the following
tasks. Each task will have its own set of steps to complete. Youmust complete these tasks on every
computer that will function as a AbilaMillennium reporting server:

Preparing to Install the Reporting Server

Running the installation program to install the necessary files on to the Reporting Server computer.

Configuring the Reporting Server.

Configuring theQueue to run as aWindows Service or to run as an application.

After installing/upgrading and configuring each computer that will function as a Reporting Server, you
will:

Configure (or verify the configuration on) the AbilaMillennium System Information page for
Reporting.

Test Reports.

Note: The following instructions apply to both new installations and to organizations who are
upgrading. For upgrading organizations, some of the configuration tasksmight not be necessary, but
it is important to review all configuration steps to verify that your settings are correct.

Preparing to Install the Reporting Server
1. Complete the installation and configuration of theWeb Server (IIS) and theDatabase Server.

2. Each Reporting Servermust meet, or exceed, the system requirements. You can view the latest
system requirements at abila.com/solutions/millennium.

3. Back up the computer so that the system can be restored (if needed).

4. Stop or close (if necessary) the Reporting Queue:

a. If you are running theQueue as a service:

i. Start>Control Panel>Administrative Tools.

ii. Double-click Services.
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iii. In the Services list, locate and right-clickMillennium Queue Service.

iv. Click Stop.

b. If you are running theQueue as an application: verify theQueue.exe application (the
standard location for this application is in theQUEUE directory on the Reporting Server
computer) is not running.

5. If you are running AbilaMillenniumReporting Server versions 2014 to 2016, you can upgrade
directly to version 2017.1. Reporting Server versions prior to 2014 must be uninstalled before
you can install version 2017.1.

Installing/Upgrading the Reporting Server
The Reporting Server installation program allows you to install or upgrade an AbilaMillennium
Reporting Server. Youmust run this installation programon every computer that will function as a
Reporting Server.

To install the Reporting Server on one computer:

1. Log on to the Reporting Server computer as the site administrator with administrative privileges
on the computer.

2. At the Reporting Server computer, double-click on the self-extracting zip file. The installation
program should start automatically. If it does not start, browse to the directory into which the
install files were extracted, and launch AutoRun.exe.

3. Once the installation programbegins, select Install Millennium Reporting Server.

4. The installation programperforms a check for components that are required to be installed on the
Reporting Server computer. If one ormore of the following items aremissing, the installation
programwill display the install requirements page.

Microsoft .NET Framework 4.5 Full

Microsoft Visual C++ 2012 Redistributable Package update 4 (x86)

Crystal Reports 2008 SP4 run time components

5. Click Install to install the prerequisite components.

6. On thewelcome page, clickNext to proceed.
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7. On theDestination Folder page, indicate the location where Reporting Server will be installed. You
can accept the default location or click Change to specify a different one. ClickNext.

8. Make sure you clickNo for the option to Remove Crystal Reports. SelectingNo prevents the
upgrade from removing existing Crystal reports from the system.

9. On theReady to Install the Program page, Click Install.

10. When the installation is complete, the InstallShield Wizard Completed page displays to indicate
that the Reporting Server was successfully installed. Click Finish.

11. Perform the configuration tasks to complete the Reporting Server installation and configuration
process. Steps are provided in the Configuring the Reporting Server section in this chapter (below).

Configuring the Reporting Server

Complete the following steps to configure the Reporting Server:

1. If necessary, recreate the IIS Server Anonymous Access User (MillAppPool Identity) on the Reporting
Server computer.

Important!
When you installed and configured theWeb Server (IIS) component of AbilaMillennium, you also
created/identified an Anonymous Access User and then set theMillAppPool Identity to this
Anonymous Access User. The IIS Server and all Reporting Server computersmust have a common
user account to use as the Anonymous Access user. You can use a domain account, or you can
use a local user account that can be recreated on the Reporting Server computer. An account that
is recreated on Reporting Server computersmust have the same user name and password as the
account on the IIS Server. If your system is distributed over different computers, then you cannot
use the IIS IUSR built-in account.

2. At the Reporting Server computer, enable log on locally rights for Reporting Server's Anonymous
Access User.

a. Start>Control Panel>Administrative Tools>Local Security Policy. Run as administrator.

b. On the Security Setting pane, expand Local Policies. Click User Rights Assignments.

c. Double-click theAllow log on locally (or Log on locally) security setting. Add the Anonymous
Access User account, and clickOK.

3. TheUser Group to which theQueueUser belongsmust have Read andWrite permissions to the JSI
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FundRaising Systems, Inc. registry key. If theQueueUser already exists on the Reporting
Server computer (as in the casewhen theQueuewill be run as an application, or when using an
existing QueueUser when you install theQueue as a service), verify that theQueueUser is a
member of a group that has the correct permissions to the JSI FundRaising Systems, Inc.
registry key. If not, then theQueueUsermust bemoved to a group with the correct permissions.

4. If you want to run theQueue as a service, follow the instructions in Appendix D: Installing and
Running theQueue.

Note: Running as a service ensures that theQueue is always available for processing reports.

5. At the Reporting Server computer, use Table 2: Reporting Server Security and Share
Permissions to share directories and to grant directory security and share permissions.
Remember that the Anonymous Access User on the Reporting Server is identical to the
Anonymous Access User (MillAppPool Identity) on theWeb (IIS) Server.

Directory Share? Security Permissions Share Permissions

\QUEUE Yes Anonymous Access User - Full
Control

QueueUser - Full Control

Anonymous Access User - Full
Control

QueueUser - Full Control

\windows\temp No QueueUser - Full Control

Table 2: Reporting Server Security and Share Permissions

6. At the Reporting Server computer, create the 32-bit (only) ODBCWeb SQL connection. If
necessary, refer to Appendix B: Creating the Web SQL ODBC Connection to your Database for the
steps.

7. The Reporting Server QueueUser account must be recreated, with identical user name and
password, on theWeb Server (IIS) computer. This recreated QueueUser account must also have
specific shares and permissions to several of the directories on theWeb Server (IIS) computer. If
the Reporting Server QueueUser does not already have an identical user account on theWeb
Server (IIS) computer, and/or the necessary shares and permissions for theQueueUser have not
yet been set on theWeb Server (IIS) computer, then complete the following tasks at theWeb
Server (IIS) computer:

a. Create theQueueUser account on theWeb Server (IIS) computer if it does not already exist.
The name and password for theQueueUser on theWeb Server (IIS) computermust be
identical to the name and password for theQueueUser on the Reporting Server computer.
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b. At theWeb Server (IIS) computer, use Table 3: IIS Server Security and Share Permissions
for the Queue User to grant directory security and share permissions to theQueueUser,

Directory Security Permissions Share Permissions

\inetpub\wwwroot\mill\formats (SQL)
or

\inetpub\wwwroot\mill\oracleformats
(Oracle)

QueueUser - Full Control QueueUser - Full Control

\inetpub\wwwroot\mill\reports QueueUser - Full Control QueueUser - Full Control

\inetpub\wwwroot\mill\docs

(or the virtual directory containing the
Docs folder, if you are not using the
default location

QueueUser - Full Control QueueUser - Full Control

\inetpub\wwwroot\mill\exports QueueUser - Full Control QueueUser - Full Control

Table 3: IIS Server Security and Share Permissions for theQueueUser

8. Verify that the following services are started.

a. The relevant database services (SQL Server or Oracle services) are started on theDatabase Server
computer.

b. queue.exe (the application) is running on the Reporting Server computer if you are running the
Queue as an application.

Or,Millennium Queue Service is started on the Reporting Server computer if you are running
theQueue as a service.

c. TheWorld Wide Web Publishing Service is started on theWeb Server (IIS) computer.

"Configuring theWeb Server (IIS)" (page 19) lists the steps to follow to verify that a service is started
on a Server.
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Configuring System Information for Reporting
After the Reporting Servers have been installed and configured, log on to AbilaMillennium as a system
administrator and navigate to Tools>System Upkeep>System Information. Configure (or verify
the existing configuration for) the System Information page to accurately reflect the following:

Reporting Information

Institution: TheNameof your organization.

HTML Report Location: This is the directory whereHTML and PDF report output files are stored.
(This field must contain theUNC path to the IIS Reports directory (in the form: \\<IIS Server
name>\Reports).

Report Template Format Location: This formats directory is the location of the standard Crystal
Report format files (RPT) supplied by Abila as well any custom formats you create. Enter theUNC path
to the IIS Formats directory (in the form: \\<IIS Server name>\Formats for SQL Server, or \\<IIS
Server name>\OracleFormats for Oracle)

Default Format Location: Enter the UNC path to the default IIS Formats sub-directory (in the form:
\\<IIS Server name>\Formats\Bio for SQL Server, or \\<IIS Server name>\OracleFormats\Bio
for Oracle).

Default Export Path: This is the default UNC path your site will usewhen exporting report data in
DOC, XLS or other output format (\\<IIS Server name>\<Exports>, where <Exports> is the name
of the directory you created). The systemwill send exported data to this directory. It will not send
exported data to the location of published reports. In order for the system to send report export files
to the <Exports> directory, appropriate shares and permissionsmust be applied. If necessary, review
"Configuring theWeb Server (IIS)" (page 19) for information about the appropriate shares and
permissions on the <Exports> directory.

Photos Location: Enter the full UNC path for theDocs Virtual Directory. TheDocs Virtual Directory is
the location of the AbilaMillenniumAttachments. In order for the system to display photos on
reports, appropriate shares and permissionsmust be applied. If necessary, review the "Configuring
theWeb Server (IIS)" (page 19) for the appropriate shares and permissions on the <docs> directory.

Reporting Queues (SQL Server)

Queue: Your name for the specified queue.
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Queue Location: Enter the UNC Path to Queue.exe. (in the form: \\<Reporting Server machine
name>\Queue).

Database Computer: This is the name of the server (as identified in your network) where themilldata
database or a replicated copy of the database is located.

If you havemultiple database instances on the same server, you will specify the <server
name>\<instance name>.

Data Database: Name of your database, (case sensitive); for example,milldata.

Primary Database Computer: Actual systemnameof theDatabase Server where production
database resides.

If you havemultiple database instances on the same server, you will specify the <server
name>\<instance name>.

Reporting Queues (Oracle)

Queue: Your name for the specified queue.

Queue Location: Enter the UNC Path to Queue.exe. (in the form: \\<Reporting Server machine
name>\Queue).

Database Alias: Enter theNet easy connect string for the reporting database. If your reporting
database is not replicated, this information will be the same as the alias for the primary database.

ODBC DSN: EnterWeb SQL.

Primary Database Alias: Enter theOracle Net Service name for the production database.

Replicated Databases (SQL Server)

Replicated Database Computer: Name of replicated server.

Database: Name of database on the replicated server.

Note: If you set up a replicated database, this section of the System Information page is used to
register - with AbilaMillennium - the name of the computer and the name of the database on that
computer where the replicated database is found.

Replicated Databases (Oracle)

Replicated Database Alias: theNet easy connect string for replicating database.
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Note: If you set up a replicated database, this section of the System Information page is used to
register - with AbilaMillennium - theNet easy connect string for the replicating database.

Reporting Printers

To define printers for AbilaMillennium, refer to Appendix E: Defining Printers.

Queue: The exact name of theQueue on which the printer is to be registered.

Printer Description: Ameaningful name that you want to use to associate the printer with this
Queue.

Printer Location: The internal code for the printer. For examples - "Ne00", "Ne01".

Printer Name: The name of the printer as it is recognized on theQueue computer. For example -
\\printserver\printer

Printer Driver: The name of the printer driver. Often, but not always, the driver will bewinspool.

Testing Reports
Once you install and configure the Reporting Servers and configure the reporting related components
on the System Information page, complete the following tests:

Run an unmodified standard report that includes prompts and Crystal parameters to completion
(Single Line with Gift Totals, for example). Test the report through every Queue that you have
configured.

Verify that you can print an unmodified standard report to each of the printers that you have
defined.

Run an On-Demand report (Full Profile for example) for a constituent.

Note: AbilaMillenniummakes every attempt to ensure that your custom reports will run after
upgrading to the latest version of AbilaMillennium. However, due to the highly customizable nature
of reports, we cannot guarantee that all custom reports will run after an upgradewithout
modification.
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This chapter discusses configuration settings and considerations for workstations andmobile devices.

Beforeworkstations andmobile devices can be configured for AbilaMillennium, theWeb Server (IIS),
Database Server, and Reporting Server componentsmust be installed and configured. See Chapter 2:
Installing the Web Server (IIS) and Database Server and Chapter 3: Installing the Reporting Server for
information about installing and configuring these components.

After AbilaMillennium is installed and configured on theWeb (IIS) and Reporting Servers, any
computer that meets theworkstation system requirements can access the application with aweb
browser.

You can view the latest workstation requirements at http://www.abila.com/solutions/millennium.

Installing and Configuring Java
Recent versions of Millenniumhave removedmuch of the Java processing from the application.
Several features, however still use Java, so this step is still an important part of the installation.

Before you begin, we recommend you uninstall all instances of Java that are currently installed on
the computer.

Important! This is what we recommend. However, you should evaluate the java needs of other
software that you use before uninstalling java.

Use the following steps to remove existing versions of Java from the computer:

1. Access the Java Control Panel by using Start>Control Panel>Java. On theGeneral tab, in the
Temporary Internet Files section, click Settings.

2. On the Temporary Files Settings dialog, click Delete Files.

3. On theDelete Files and Applications dialog, select all enabled check boxes, and clickOK.

4. ClickOK to close the Temporary Files Settings dialog. ClickOK to close the Java Control Panel
(if necessary).
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5. On theControl Panel, click Programs and Features. Uninstall all instances of Java that are
listed.

To install the recommended version of Java, use the following methods:

Install Java from java.com.

Youmay be redirected to a test page on the javawebsite to verify your installation.

To Configure Java for use with Abila Millennium, use the following steps:

1. Access the Java Control Panel by using Start>Control Panel>Java.

2. On theGeneral tab, in the Temporary Internet Files section, click Settings. Select theKeep
temporary files on my computer check box, and click Apply.

3. Click theUpdate tab. If theCheck for Updates Automatically check box is selected, then clear
it and click Apply.

4. ClickOK to close the Java Control Panel.

Important! After configuring Java, close all open browser windows.

Java Security Warnings

Beginning with Millennium version 2016.1, a secure connection is required for theMillenniumWeb
Server. The log in page, which previously used a java applet for non-secure sites, will no longer be
available if a certificate is not installed for the application.

However, a number of java applets do continue to run in the application. Youmight be required to
positively acknowledge (Run or Allow) any security warnings that Java displays to continue your work.
The Java security warning includes a setting that allows you to disable thewarning for the Abila
Millenniumwebsite and the application named on thewarning.

Configuring Your Browser Settings for Use with Abila
Millennium

Important! Although AbilaMillennium supportsmultiple browsers, if you are accessing the system
as aMillennium system administrator or as the database administrator, please use Internet
Explorer.

http://www.java.com/
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Configure Your Browser Settings for Internet Explorer

To configure your browser settings for Internet Explorer:

1. Open Internet Explorer.

2. Set the text size (View>text size) to avoid horizontal scrolling.

3. Click theGear icon at the top right corner of your browser window, and click Compatibility View
Settings. If this item is not available from theGear icon, then click on the Internet Explorer Tools
menu and click Compatibility View Settings.

4. On theCompatibility View Settings dialog:

a. If theMillenniumURL is shown in theWebsites you've added to Compatibility View list,
select it and click Remove.

b. if theDisplay intranet sites in Compatibility View check box is selected, then clear it.

5. Click Close. Formore information about removing Compatibility View, see "Remove Compatibility
View" (page 42)

Click theGear icon at the top right corner of your browser window, and click Internet options.
Complete the remaining configuration tasks on the Internet Options dialog:

9. On theGeneral tab: In theBrowser history section, click Settings, select Every time I visit the
webpage, and clickOK.

10. Click Apply.

11. Click the Privacy tab. In the Settings section, set the Internet zone toMedium, Low, orAccept
All Cookies.

12. Click Apply.

13. Click the Security tab. Select the Trusted Sites zone.

14. Click Sites. On the Trusted sites dialog:

a. Add the AbilaMillenniumwebsite.

b. If you will be processing Credit Card and Bank Draft transactions, and entering credit card
number and bank account numbers (using either Sage Payment Solutions or the free Sage

Abila Millennium
Installation Guide

38



Chapter 4: Configuring Workstations for Millennium

Abila Millennium
Installation Guide

39

Exchange Vault only), add https://www.sagevault.com too.

c. Click Close.

15. Remain in the Trusted Sites zone on the Security tab. In the Security level for this zone
section, click Custom Level. In the Settings box:

a. UnderActiveX controls and plug-ins set the following options:

i. UnderAutomatic Prompting for ActiveX controls, select Enable.

ii. UnderDownload signed ActiveX Controls, select Enable or Prompt.

iii. Under Initialize and Script ActiveX Controls not marked as Safe for scripting, select
Prompt.

iv. UnderRun ActiveX Controls and Plug-ins, select Enable or Prompt.

v. Under Script ActiveX Controls marked safe for scripting, select Enable or Prompt.

b. UnderMiscellaneous set the following option:

i. Under Include local directory path when uploading files to a server, select Enable.

c. ClickOK.

16. Click Apply.

17. Click theContent tab. In theAutoComplete section, click Settings.

a. Clear the Forms andUsernames and passwords on forms check boxes.

b. ClickOK.

18. Click Apply.

19. Click theAdvanced tab. In the Settings box:

a. UnderBrowsing, set the following options:

i. Select Disable script debugging.

ii. ClearDisplay a notification about every script error.

iii. ClearUse smooth scrolling.
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b. Under Security, set the following options:

i. Select Do not save encrypted pages to disk.

ii. Select Empty Temporary Internet Files folder when browser closed.

c. ClickOK.

20. ClickOK on the Internet Options dialog, and then close Internet Explorer.

Configuring Your Browser Settings for Firefox

The following Abila Millennium features will not work with Firefox:

Write a Letter

CustomDisplay Designer

To configure your browser settings for Firefox:

1. Open Firefox.

2. From the Toolsmenu, click Add-Ons to open theAdd-ons Manager. Click Plugins. Locate the
Java Platform SE item. Click Always Activate if it is currently set toNever Activate orAsk to
Activate. Close theAdd-onsManager.

3. From the Toolsmenu, clickOptions.

4. On theOptions dialog, click Security. Disable saved passwords for the AbilaMillenniumwebsite by
using one of these two options:

a. In the Passwords section, clear theRemember passwords for sites check box.

b. In the Passwords section, Click Exceptions. Add the AbilaMillenniumwebsite to exceptions list,
and click Close.

When you first log on to AbilaMillennium clickNever for this site when you are prompted to
Save Password.

5. Remain on theOptions dialog. Click Privacy. In theHistory section, from the Firefox will box,
select Use custom settings for history.

a. ClearRemember search and form history.

b. Select Accept cookies from sites.
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6. Remain on theOptions dialog. Click Content. If Block pop-up windows is selected, click
Exceptions. Add the AbilaMillenniumwebsite on theAllowed Sites - Pop-ups dialog, and click
Close.

7. ClickOK to close theOptions dialog.

8. Firefox now enables Javascript by default. If you need to verify that Javascript is enabled, type
about:config and click Enter. In the Search box, type in javascript.enabled. Verify Status is set to
default and Value is set to true.

9. Firefox requires the LocalLink extension in order to use the AbilaMillenniumCustomUtilities
feature. LocalLink can be downloaded from addons.mozilla.org/en-US/firefox/addon/281.

10. Firefox requires the IE Tab extension in order to use the AbilaMillenniumUpload Contacts to
Outlook and IntegrateMillennium Tasks with Outlook features. IE Tab can be downloaded from
addons.mozilla.org/en-US/firefox/addon/1419.

Caution! AbilaMillenniumdatamaintenance forms have data checking routines in place to insure
that you enter data that conforms to database and common sense rules. If you enter data that
does not pass a data checking routine, an errormessage is displayed. Close themessage andmake
the needed corrections. Firefox may show a Prevent this page from creating additional
dialogs check box on the errormessage. If this check box is on the errormessage,do not select it!
You could be by-passing data checking routines and suppressing legitimate errormessages. This
may result in either generating SQL errors as the form attempts to enter invalid data into your
database, or entering nonsense data into your database!

Configure Your Browser Settings for Chrome

No changes need to bemade to Chrome settings in order to successfully access AbilaMillennium.

On-Demand Reports
To viewOn-Demand reports and reports that have been published to PDF, youmust have Adobe
Acrobat Reader installed. Obtain Adobe Acrobat Reader for free at get.adobe.com/reader/.

Write a Letter Feature
TheWrite a Letter featureworks only for Internet Explorer. To use the system'sWrite a Letter
feature, one of the following versions of Microsoft Wordmust be installed (on the client workstation):
2002, 2003, 2007, 2010, 2013, or 2016.

https://addons.mozilla.org/en-US/firefox/addon/281
https://addons.mozilla.org/en-US/firefox/addon/1419
http://get.adobe.com/reader/


Mobile Access to Millennium

Mobile Access to Millennium
Themobile directory is in the following location on theWeb Server (IIS) computer:
http://www.<Server Name>.com/mill/mobile. If your organization is upgrading to version 2017.1
from version 2013 or earlier, this is a different directory location. Every user who accessesMillennium
by using amobile devicewill need to update the shortcut or Favorites destination to this new location.

Important! Users who plan to accessMillennium from amobile device fromoutside your
organization's network will need to first contact the network administrator for instructions on how to
do so.

Remove Compatibility View
TheMillenniumweb site will not work with Compatibility View in Internet Explorer (IE) Version 11. IE
Version 11 is required to run themost recent updates of the product, including theMillennium
Reporter. So youmust remove any compatibility view settings that might have been previously set for
theMillenniumweb site when you upgrade to this version of the product.

Use the following steps to remove the Compatibility View settings from Internet Explorer:

1. Open Internet Explorer.

2. Select Settings>Compatibility View settings.

3. In theWebsites you've added to Compatibility View, select theMillenniumweb site.
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4. Click Remove.

5. Clear the check box option toDisplay intranet sites in Compatibility View.

6. Click Close.



Chapter 5: Display and System Settings

This chapter describes several additional installation considerations: AbilaMillennium interface
customizations, display options, and systemoptions.

AnMillennium system administrator should review theDisplay Options, SystemOptions, and System
Information.

—Back up theDatabase Server computer and yourMillenniumdatabase so that the system can be
restored if a problemoccurs.

— Log on to theDatabase Server computer as the site administrator with administrative privileges on
the computer.

— Log on as aMillennium system administrator.

Two utilities are included with the system to help you keep your ZIP code and address table up to date
and this chapter provides an overview of these two utilities.

File Search, Log Off User, Merge ID, and User Dump are system administrator utilities that are accessed
through the user interface. In this chapter you will find the passwords that are needed to log on to
these utilities.

Saving Customized Displays and Forms
New columns have been added for Summaries (to thememories data table), and new columns have
been added to the following lookup tables: Action Type,Address Utilization,Attribute Types,
Correspondence Names, Correspondence Type,Dues Types,Gift Types,Memory Names,
Relationships, Table Groups, Tasks Type.

If you are upgrading from version 2013.0.x or 2014.0.x, and you want to display or use the new
columns, youmust resave your customized datamaintenance and display forms. To access the
CustomDisplay Designer for Summaries, log on to the system as a AbilaMillennium system
administrator, and select in the AbilaMillennium Explorer, Tools>Display Design>Profiles. Select
Profiles>Giving>Summaries. To access the CustomDisplay Designer for Lookup tables, use
Tools>Display Design>Lookups. Select Lookups><the alias name of the lookup table>.
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Note: In earlier releases,Action Type,Address Utilization, Correspondence Type,Dues Types,
Gift Types,Memory Names, and Table Groupsmaintenance and display forms could all be
customized by using the Standard Lookup screen layout. Now youmust use a separate screen
layout to customize each of these tables. TheAttribute Types, Correspondence Names,
Relationships, and Tasks Type lookup tables have always used separate screen layouts.

System-wide Display Options
To access Display Options select Tools>Display Design>Display Options.

—Default Screen Resolution: Determines if the screen resolution isHigh or Low, used in
reporting.

— Spouse Button Label: This option allows the system to display either 'Spouse' or
'Spouse/Partner' as the label on the Spouse Button. The default label display is 'Spouse'.

— Prospect Count Label: The FavoritesMy Prospects display includes a count of the total number
of prospects in the upper right corner of the display. This option allows you to display a custom label
for this count.

—Display Masks: This determines how each encrypted columns data is displayed for Social
Security number and Bank Account number for those users that have been assigned to the
Default Mask display mask option. Enter a '9' for digits you want to display and enter '#' for digits
you want masked.

Search Results Setup options

Search Results Setup options are displayed on andmaintained from theDisplay Options page.

— Search Results Display: This option allows you to choose the columns to display on the Search
Results page.

—ADE Search Results Display: This option allows you to choose the columns to display on your
Advanced Data ExaminerMatching Levels Search results display.

—My Staff Display: This option allows you to choose the columns to display on your FavoritesMy
Staff listing.

—My Prospects Display: This option allows you to choose the columns to display on your Favorites
My Prospects listing.



System Information

—My Prospects Filters: This option allows you to definewhat database fields are available to use to
filter your FavoritesMy Prospects listing.

Table Options

To access Table Options, select Tools>Display Design>Table Options.

— If there are data tables not used at your organization, they can be removed from the Abila
Millennium Explorer. This will not remove them from the database. Not all data tables can be removed
fromAbilaMillennium Explorer.

— If you want to display a different name for your CustomBio and your CustomProspect tables, then
you can type in theDisplay Name for either one of these two tables.

System Information
To access System Information, select Tools>System Upkeep>System Info.

—Database Server: Verify or edit the Database Server engine type.

— Internet Directory: Verify that the Internet Directory path is correct. Edit if changes are required.
Enter the complete path name of the Internet Root Directory: X:\inetpub\wwwroot\mill (substitute
the correct drive letter for X).

—Millennium_Admin password: The edit button allows you to modify the database password for
themillennium_admin log on.

Important! Alwaysmakemillennium_ admin password changes through the AbilaMillennium
interface.

— Registration Number: This number is supplied with theMillennium Installation. It is a site specific
number that activates the system and any addition features (such as the Advanced Data Examiner) that
you have purchased. Verify that it has been entered correctly.

— Serial Number: This number is supplied with theMillennium Installation. It is a site specific number
that works in conjunction with your registration number. Verify that it has been entered correctly.
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System Options
To access System Options, select Tools>System Upkeep>System Options.

— Remove Formatting from Comments: Depending on the option selected, the systemwill
remove tabs, line feeds and carriage returns from all comments when they are saved to the database
(during insertion and update). Or, the comments are saved to the database in the sameway as they
are entered, but the formatting will be removed for display purposes only. Or the comments are
saved to the database and displayed in the sameway as they were entered.

— Remove Formatting from Text Boxes: Depending on the option selected, the systemwill
remove tabs, line feeds and carriage returns from text that is entered in text box controls when the
text is saved to the database (during insertion and update). Or, text is saved to the database in the
sameway as it is entered, but the formatting will be removed for display purposes only. Or text is
saved to the database and displayed in the sameway as it was entered.

—Audit user log in attempts: When this option is enabled, the systemwill record every attempt,
successful or not, that ismade to log on to Millennium.

—Number of login failures before user lockout: Lock users out of Millennium if they havemade
this number of unsuccessful attempts to log on. If you set this number to 0, then the systemwill not
lock out users for failed log on attempts.

—Duration of lockout: This option can be set to allow locked out users another chance to log on to
Millennium after a certain time length has passed. If you set the Duration of lockout to 0, and the
Number of login failures allowed to a number greater than 0, then only a system administrator can
unlock a locked out user.

—Assignment Frequency: This determines the amount time, in minutes, that the assignment
server waits between assignment runs. The default is 5 minutes. This setting allows the system
administrator to set an institutional limitation on all assignments for all users, as to themaximum
frequency assignments will be checked.

—Advisory Notification Return E-mail Address: The Assignments and Advisory Notification
components of My Millennium can be set up so that the systemwill generate e-mail messages to
notify users when Advisories have been posted. If you wish for these notifications to have a return e-
mail address, then enter it here.



System Options

—Degrees of Separation Limitation: This determines the number of 'degrees of separation' that
each usermay specify in hyperbolic Relation Tree displays. MaximumDegrees of Separation used in the
Relation Tree is seven.

— Check Preferred Names: When set to Yes, the systemwarns users during data entry if a preferred
namedoes not exist for a constituent or if a constituent hasmultiple preferred names.

— Check Preferred Address: When set to Yes, the systemwarns users during data entry if a
preferred address does not exist for a constituent or if a constituent hasmultiple preferred addresses.

—Allow Constituents who have Giving or Dues Data to be Deleted: This option allows you to
choosewhether to allow the deletion of all data belonging to a specific constituent (by deleting the
Basic Data row), when that constituent owns Giving or Dues transaction data rows.

—Beginning month of Fiscal Year: Select your fiscal year start month from the drop-down list.

—Matching Tender Default: Determines the default Tender Type forMatching Giving.

—Display Matching Payment Schedule: This option allows you to choosewhether or not to allow
for the creation of a pledge payment schedule formatching pledges that differs from the default
payment schedule inserted by the system

— Pull the Matching Ratios from the Corporation: This check box determines whether or not the
systemuses thematching company or thematch through constituent when creatingmatch pledge or
match potential transactions.

—Automatically Journal Credits and Honors: This option allows for the automatic journal of all
honor and credit transactions that are linked to theGift or Dues transaction that is being journaled.

—Update Credits and Honors: This option allows the system to automatically update linked credits
and honors at the time of the transaction update.

—Update Payment Transactions: This option allows the system to automatically update the
Purpose, Campaign, Class1 and Class 2 fields on payments when those fields are updated on the
associated allocation.

—Default Benefit Delivery Date: When this option is checked and a benefit is inserted, the Benefit
Delivery Datewill automatically be filled in with the same date as theMembership Renewal Date.

—Allow ID number's to be Copied from the Search Results Screen to the Clipboard: Yes or No
to allow users to save ID numbers from the results of a constituent Profile Search, as a string, to the
Clipboard.
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— Tasks Integration with Outlook: This option tells the system to allow users to integrate
Millennium Tasks with Microsoft Outlook. If integration is allowed, it can beManual or Real-time.
Users who accessMillenniumby using Firefox must have IE Tab Extension installed.

—Allow Contacts to be Uploaded to Outlook: This option tells the system to allow users to
upload constituent contact information (name, address, phone number, and so forth) to Microsoft
Outlook. Users who accessMillenniumby using Firefox must have IE Tab Extension installed.

— Enter the home institution - If your organization has an active entry in the Institutions lookup
table, you can identify one of the entries as your home institution. When constituent Education
records are viewed inMillennium, the systemwill highlight the records that have an Institution equal
to your organization's home institution.

Auditing options

Auditing options are displayed on andmaintained from the System Options page.

—Check the box next to the name of each table for which you want to turn on audit logging.

Password Options

Password options are displayed on andmaintained from the System Options page.

—Allow users to change their password: Enables users to change their own AbilaMillennium
passwords. If enabled, you also have the option to Force all Users to change password at next
login as well as Set Force password flag to 'Off' for all Users.

— Required password length: If the change password option is enabled, youmay specify the
minimumpassword length here (up to 30 characters).

— Password will expire in: This setting determines the frequency (# of days up to 999) before a
usermust change their password. Enter 0 days to indicate passwords never expire.

—Minimum number of alphabetic characters: Specify theminimumnumber of alphabetic
characters you wish the user to incorporate into their new password.

—Minimum number of numeric characters: Specify theminimumnumber of numeric
characters you wish the user to incorporate into their new password.



System Options

Sage Payment Solutions OR SPS Vault Only Account options

Sage Payment Solutions and SPS Vault Only options are displayed on andmaintained from the System
Options page. Your sitemay have one or the other, but not both.

— ID: This number is supplied if you have purchased the Sage Payment Solutionsmodule. It is a site
specific number that activates thismodule.

— Key: This number is supplied if you have purchased the Sage Payment Solutionsmodule. It is a site
specific number that activates thismodule.

— If youmaintain an SPS Vault Only account, enter and update contact information for the account.

—Allow accounts to be saved for future use: This optionmakes the account number available for
usewith future transactions with a Tender Type of credit card or bank draft.

Initium Software Options

—Organizations that use the Initium Software Instant Address servicewill enter the URL provided by
Initium on the Initium Setup page. This page is accessed from the System Options page.

Serialized Tax Receipting Options

Serialized Tax Receipting options are displayed on andmaintained from the System Options page.

— Enable Serialized Tax Receipting: Clear the check box if you do not want to utilize Serialized Tax
Receipting at your site. If you want to utilize this feature, then fill out the remaining fields.

—Next Receipt Number: View the next receipt number, or click the Edit button to reset it. The value
must be numerical, and amaximumof 10 digits.

— Receipt Prefix: View the receipt prefix, or edit it by clicking the Edit button. The receipt prefix must
be alphanumeric.

— Charitable information to be printed on each receipt: Enter the information as you want it to
display on the receipts.

WealthEngine Options

WealthEngine options are displayed on andmaintained from the System Options page.

If your organization uses a proxy service account to accessWealthEngine, then you will provide
information for the following fields:
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—Username: This is the user name used at your organization to activate thismodule and it is
supplied by WealthEngine.

— Password: This is the password used at your organization to activate thismodule and it is supplied
by WealthEngine.

— TheUser box that lists the names of all users, and the Import and Search options are used to
grant WealthEngine access to AbilaMillenniumusers.

If your organization uses named accounts to accessWealthEngine, then you will provide information
for the following fields instead:

—Account name fields: These are named accounts used at your organization and they are supplied
by WealthEngine

— TheUser box that lists the names of all users, and the Import and Search options are used to
assignWealthEngine account names to AbilaMillenniumusers. Once a AbilaMillenniumuser has been
assigned to aWealth account name, he/shemust then accessMy Millennium to record his/her
WealthEngine password in AbilaMillennium.

Utility Passwords

AbilaMillenniumprovides several utilities accessed through the interface, and are for use by system
administrators. Each utility has a password:

File Search: director

Log Off User: logger

Merge ID: merger

User Info Dump: dumper



Appendix A: IIS Services and Features

Use the information in the following sections to help you establish the IIS services and features
required for AbilaMillennium.

System Services
The following IIS system servicesmust be installed and activewhen you install Millennium.

Display Name Service Name Start

Application Host Helper Service AppHostSvc Automatic

ASP.NET State Service aspnet_state Manual

IIS Admin Service IISADMIN Automatic

SimpleMail Transfer Protocol (SMTP) SMTPSVC Automatic

Windows Process Activation Service WAS Automatic

WorldWideWeb Publishing Service W3SVC Automatic

WebManagement Service WMSVC Manual

Role Services
The following IIS role servicesmust be installed and activewhen you install Millennium.
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Name Components

Common HTTP Features Default Document

Directory Browsing

HTTP Errors

HTTP Redirection

Static Content

Health and Diagnostics Custom Logging

HTTP Logging

Logging Tools

ODBC Logging

Request Monitor

Tracing

Performance Dynamic Content Compression\

Static Content Compression

Security Basic Authentication

Request Filtering



Role Services

Name Components

Management Tools IIS Management Console

IIS Management Scripts and Tools

Management Service

Application Development .NET Extensibility 3.5

.NET Extensibility 4.5

Application Initialization

ASP

ASP .NET 3.5

ASP .NET 4.5

CGI

ISAPI Extensions

ISAPI Filters
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Features
The following IIS featuresmust be installed and activewhen you install Millennium.

Name Path

.NET Framework 3.5 Features .NET Framework 3.5 (includes .NET 2.0 and 3.0)

.NET Framework 4.5 Features .NET Framework 4.5

ASP .NET 4.5

WCF Services\TCP Port Sharing

Remote Server Administration Tools Feature Administration Tools

SMTP Server Tools (Required for SMTP Server)

SMTP Server SMTP Server

Windows Process Activation Service ProcessModel

WoW64 Support WoW64 Support



Appendix B: Creating the Web SQL ODBC
Connection to your Database

Use the tasks in this topic to create an ODBC connection to yourMillenniumdatabase.

SQL Server
1. Create a 32-bitWeb SQLODBC connection pointing to yourAbila Millennium database. (The

standard name for the AbilaMillenniumdatabase ismilldata).

a. Open theODBC Data Source Administrator:

i. Access the Run command by pressing theWindows logo key + R

ii. In theOpen box, type in C:\windows\SysWOW64\odbcad32.exe, and clickOK.

b. Select the System DSN tab, and click Add.

c. On theCreate New Data Source dialog, select SQL Server Native Client,, and click Finish.

d. On theCreate a New Data Source to SQL Server dialog:

i. TypeWeb SQL in theName box.

ii. Type a description for the connection in theDescription box if you want.

iii. In the Server box, select the name of the SQL Server where the AbilaMillenniumdatabase
resides, and clickNext.

e. On theMicrosoft SQL Server DSN Configuration dialogs:

i. Select theWith SQL Server authentication... option.

ii. Verify that theConnect to SQL Server to obtain default settings... check box is
selected.

iii. Type in the sa user name in the Login ID box and the sa password in the Password box,
and clickNext.

iv. Select Change the default database to, and select the name of your AbilaMillennium
database.
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v. Verify that Use ANSI quoted identifiers andUse ANSI nulls, paddings and warnings
check boxes are selected, and click Next.

vi. Clear the Perform translation for character data check box, and click Finish.

f. TheODBC Microsoft SQL Server Setup dialog displays. Review the configuration. Click
Test Data Source to test the connection.

g. Once you have a successful connection, clickOK.

h. ClickOK to close theODBC Data Source Administrator.

Oracle
1. Create theOracle Net Service connection to the AbilaMillenniumdatabase.

2. Create a 32-bitWeb SQLODBC connection pointing to yourAbila Millennium database.

a. Open theODBC Data Source Administrator:

i. Access the Run command by pressing theWindows logo key + R

ii. In theOpen box, type in C:\windows\SysWOW64\odbcad32.exe, and clickOK.

b. Select the System DSN tab, and click Add.

c. On theCreate New Data Source dialog, select theName that begins withOracle in
OraClient, and click Finish.

d. On theOracle ODBC Driver Configuration dialog:

i. TypeWeb SQL in theData Source Name box.

ii. Type a description for the connection in theDescription box if you want.

iii. In the TNS Service name field, select theNet Service name for yourAbila Millennium
database.

iv. Typemillora in theUser ID box.

v. Clear the Enable Query Timeout check box

vi. Click Test Connection to test the connection.



Oracle

e. Once you have a successful connection, clickOK on theOracle ODBC Driver Configuration
dialog.

f. ClickOK to close theODBC Data Source Administrator.
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SimpleMail Transfer Protocol (SMTP) is the network protocol used to send email across the internet.
AbilaMillenniumwill use SMTP to send Advisory email notifications to users who set up Assignments
and choose to be notified by email once the conditions of an assignment have beenmet.

SMTP is aWindows Feature. The process to install SMTP varies slightly depending on the version of
Windows Server. You can install the SMTP server as part of theweb server installation. If you do not
install SMTP as part of theweb server installation, youmust return to the ServerManager and add
SMTP as an IIS feature before you can send email fromMillennium.

Consult with your IT department andmake sure they are aware of the following SMTP requirements
for AbilaMillennium:

To work with Millennium, SMTPmust be installed to the default location: \inetpub\mailroot. There
are several sudirectories also installed at this location.

Important! Millenniumusersmust havewrite access to this directory and its subdirectories for
emails to be sent from the application.

SMTP must be running, and the frequency for delivery must be set to Immediate.

Note: Youmust be an administrator on the server to complete the tasks described in the following
sections.

SMTP for Windows Server 2012
Use the tasks in this section to install and configure the SMTP Server onWindows Server 2012.

Set Up the SMTP Server

To Install SMTP on the Windows Server where Millennium is installed, use the following
steps:

1. Log in to theWindows server whereMillennium is installed. Youmust be an administrator on this
server to perform this task.

2. In the task bar, click the Server Manager icon . The Server Manager dashboard opens.
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3. Click Add roles and features. TheAdd roles and features wizard opens.

4. If theBefore you begin panel appears, clickNext to proceed to the Select installation type
panel.

5. Select Role-based or feature-based installation and clickNext. The Select destination
server panel opens.



SMTP for Windows Server 2012

6. In the Select destination server panel, select the server on which SMTP will be installed and click
Next. The Select server roles panel opens.

7. If you have already installed IIS on this server, proceed to Step 8. Otherwise, use the following steps
to install theweb server:

a. Select theWeb Server (IIS) role. The systemprompts you to add the features required for the
web server.
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b. Make sure the Includemanagement tools check box is selected and click Add Features to
return to thewizard.

8. ClickNext to open the Select features panel. Use the following steps to add the SMTP Server

a. Scroll the list to find and select SMTP Server.



SMTP for Windows Server 2012

b. The systemprompts you to add the features required for the SMTP server.

a. Make sure the Include management tools check box is selected and click Add Features to
return to thewizard.

9. ClickNext to proceed to the Select role service panel.
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10. Scroll toManagement Tools and select the following items:

IIS Management Console

IIS 6 Management Compatibility

IIS Management Scripts and Tools

11. ClickNext to open theConfirmation panel. The panel allows you to verify your choices.

12. Click Install to begin installing the selected roles and features.

Note: This installationmight require you to restart theWindows server.

Configure the SMTP Server

After you install SMTP, use the following steps to configure the SMTP Server for use with
Millennium:

1. From the ServerManager, click Tools>Internet Information Services (IIS) 6.0 Manager to open the
IIS 6 Manager.



SMTP for Windows Server 2012

2. In the IIS Manager, expand the server name, right-click on SMTP Server, and select Properties.

3. In theGeneral tab, accept the default settings, unless you want the SMTP Server to use a specific IP
address. Accepting the default sets the IP address to All Unassigned.
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4. Select theAccess tab.

5. Configure access settings as follows:

a. Click Authentication to verify that Anonymous access is enabled and clickOK.

b. Click Connection, select theOnly the list below option and click Add.



SMTP for Windows Server 2012

c. Enter 127.0.0.1 as the IP address, and clickOK.

d. ClickOK again to return to theAccess tab.

e. Click Relay, select theOnly the list below option and click Add.
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f. Enter 127.0.0.1 as the IP address and clickOK.

g. ClickOK again to return to the Properties window.

6. Select theMessages tab and enter a valid email address at your organization for theNon-
Delivery Report. Optionally, you can also set theBadmail directory on this tab.



SMTP for Windows Server 2012
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7. Select theDelivery tab.

8. Configure delivery settings as follows:

a. ClickOutbound Security to verify that Anonymous access is selected. Because the
Connection and Relay settings limit access to localhost, no other Outbound Security
configuration is required.



SMTP for Windows Server 2012

b. ClickOK to return to theDelivery tab.

c. Click Advanced.

d. Enter the fully-qualified domain name of the SMTP server. This is the host name or a record that
has been created in your DNS zone file.
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Important! Confirm this entry with the party that manages DNS for your domain. The
correct DNS resolution is crucial to successful email delivery. If your SMTP server cannot
resolve the domains where it is trying to sendmessages, the email process fails.

e. Click on theCheck DNS button to confirm that the domain name resolves successfully. If the
domain name resolves, the systemdisplays the following confirmationmessage.

9. Set the SMTP Service to Automatic so that the service starts when the server starts. Use the
following steps:



PTR Records for Reverse DNS Lookups

a. Open the Powershell console.

b. Run the following command:

PS C:\Users\Admin> set-service smtpsvc -StartupType Automatic

c. Run the following command to confirm that the SMTP service is running:

PS C:\Users\Admin> get-service smtpsvc

d. If the SMTP Service is not running, the command returns a status of Stopped. If the service is
stopped, use the following command to start it:

PS C:\Users\Admin> start-service smtpsvc

PTR Records for Reverse DNS Lookups
In addition to the correct host name,make sure that you configure a PTR record for reverse DNS
lookups. The PTR record allows your SMTP Server’s public IP address to resolve to your hostname.

If you do not have a PTR record, email delivery can be delayed, ormessages from your host might be
blocked, and your host blacklisted.

Formore information on testing DNS configuration, see Testing SMTP Server using SMTPDIAG tool.

Testing the SMTP Server

After Millennium is installed and the SMTP Server is enabled, use the following steps to
test that the email process is working properly:

1. At theWeb Server (IIS), verify that the SMTP Service is started.

a. Start>Control Panel>Administrative Tools.

b. Double-click Services.

c. In the Services list, locate Simple Main Transfer Protocol (SMTP).The status should be set to
Started.

2. Verify that the service is working.

a. Create a text file with the following information (first change From and To in this sample to
reflect your organization and test recipient email addresses)
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b. Drop the text file in the \inetpub\mailroot\pickup directory.

c. If the text is not delivered to the test recipient, then SMTP is not working. Contact the IT
Department at your organization for further assistance.

Online Constituent Directory
On the IISmachine, the inetpub\mailroot\pickup directory will hold the text file that is generated
when a constituent requests his or her log on information. This text file is used as the body of the
email that will be sent to all constituents who request that their log on information be sent.
Millenniumusersmust havewrite access to the inetpub\mailroot and its subdirectories for this
feature to work.



Appendix D: Installing and Running the
Queue

The AbilaMillenniumReporting Server installation will deliver all of the components that are necessary
to run the AbilaMillennium reporting Queue as either aWindows Service or as an application.

Installing and Running the Queue as a Service
The following information describes the purpose and procedures for running a reporting Queue as a
Windows Service. (As an alternative, theQueue can be run in the foreground as an application.)

Millennium Queue Service

Milqueue.exe is theMillenniumQueue Service. This service ensures that the AbilaMillenniumQueue
(Queue.exe) is always available on the Reporting Server computer so that reports can run
successfully. When theQueue operates as a service, the status will not display on theWindows task
bar when a report is run.

Queue Administration Program

QueueAdmin.exe is theQueue Administration Program. This program is installed along with the
reporting queue and is stored in theQueue directory, which is C:\QUEUE by default. The
QueueAdmin.exe program installs andmaintains theMillenniumQueue Service.

For theMillenniumQueue Service to run properly, theQueueAdmin programmust use a user account
to initialize theMillenniumQueue Service. You can specify either a domain account or a local account
based on the configuration and location of the AbilaMillenniumWeb Server (IIS), Database Server, and
Reporting Servers. TheQueue Admin program creates the user account as specified and verifies that
theMillenniumQueue Service is properly installed and running. The user account is created with only
the privileges needed to run theMillenniumQueue Service. Use this user account only for running the
MillenniumQueue Service.

Note: If you receive an error installing theQueue service, manually add theQueueUser to the
Reporting Server’s Local Administrators group, and try installing again.
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To install the Millennium Queue Service:

1. Verify that your Reporting Server computermeets or exceeds the system requirements. The latest
AbilaMillennium system requirements are available at:

abila.com/solutions/millennium.

2. Log on to the Reporting Server as an administrator who has Read andWrite permissions to the JSI
FundRaising Systems, Inc. registry key on the Reporting Server.

If you are going to create accounts onmore than one computer at the same time, then log on as a
user with Domain Admin privileges.

3. In the queue directory (this is C:\QUEUE by default), runQueueAdmin.exe. If you are using
Windows Server 2012, right-click the program and run it as an Administrator.

4. ClickNew User.

5. If you want to create a local account, leave theCompute Name radio button set.

6. If you want to create a domain account, select theDomain option, and enter the name of the
domain.

7. Enter aUser Name and Password.

8. If you want to create a local account, enter the IIS Server Name in theAdditional Computer
field. The intention here is create theQueueUser on theWeb Server (IIS) computer so that they
have access to write reports to theWeb Server (IIS) computer.

9. ClickOK.

10. Verify the password by typing it again and clickingOK.

11. The program creates the users as necessary and reports success or failure via amessage box. If
the Local Account option is chosen, twomessage boxes will appear, confirming the creation of
theQueue Account and the IIS Account. ClickOK to close themessage box.

12. Upon returning to theMillennium Queue Administrator dialog box, theUser Name and
Password fields will change, based on theNewUser that was created. Verify that the Install the
Millennium Queue Service radio button is selected. ClickOK to Install theQueue Service. A
status bar above theOK button will display certain Statusmessages. After the service has been
installed, amessage box will appear stating the successful completion on theQueue Service
Installation. ClickOK, and theMillennium Queue Administrator program closed. TheQueue
Service starts, and theQueue is available for reporting.

http://www.abila.com/solutions/fundraisingcrm/millennium/


Running the Queue as an Application

TheQueueAdmin.exe program creates theQueueAdmin.log file in the queue directory (which is
C:\QUEUE by default).

TheMilqueue.exe program creates theMilqueue.log file in the queue directory (which is C:\QUEUE
by default) when it starts the queue service. If a log on failure occurs, it is recorded in this log file.

The following registry key on the Reporting Server contains settings for theMilqueue.exe program to
use each time it starts:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JSI FundRaising Systems, Inc.\Queue Service

Running the Queue as an Application
If you run theQueue as an application, navigate to yourX:\Queue folder on the Reporting Server and
double-click onQueue.exe to start the application.

Tip:
As a work-around to running the Queue as a Service, use the following steps:

1. Right-click onQueue.exe in theX:\Queue folder and select Create Shortcut.

2. Move this shortcut to the Startup folder for theQueueUser on the Reporting Server.

When the server is restarted, theMillennium Queue Administrator application starts automatically.
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This Appendix describes using the Printers.exe utility to define yourMillenniumprinters.

Note: You can add the Report Printer information on theMillennium System Information page
without the assistance of the Printers.exe utility. But, youmust know necessary Description,
Name, Location, andDriver information for each printer that you will be adding.

Launching the Printers utility:

1. At your Reporting Server computer, navigate to theQueue folder and double-click Printers.exe.
ClickOK on themessage dialog box to continue through the utility.

2. Click theMachine Data Source tab, select theWeb SQL Data Source Name, and clickOK.

3. Youmust log on as either the database administrator (sa for SQL Server orMILLORA for Oracle)
or as aMillennium system administrator.

4. SQL Server - On the SQL Server Login dialog, type the user name in the Login ID box (if
necessary), and password in the Password box, and clickOK.

5. Oracle - On theOracle ODBC Driver Connect dialog, type the user name in theUser Name box
(if necessary), and password in the Password box, and clickOK.

6. Reporting Printers Setup dialog is shown, where all your printer setup functions can be
performed.

Printers Utility Components
Available Printers

The Printers Available for this Workstation box lists theName,Driver, and Location (each field
is separated by an asterisk) of all printers that are recognized on this specific Reporting Server
computer (the printers have been set up on the computer, throughWindows).

Reporting Queues

TheReporting Queues box lists all Queues that have been created throughMillennium. This Queue
information ismaintained in the report_servers table in theMILLREPORTS database to which the
current ODBC connection is pointing. This includes Queues on other Reporting Server computers, as
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well as on the current Reporting Server computer. When you select an entry from the list,
corresponding information is shown in the Printers Associated with the Selected Queue box.

Printers Associated with the Selected Queue

The information in this list box includes theDescription,Name,Driver, and Location (each field is
separated by an asterisk) of all printers that are currently connected (viaMillennium) to the Reporting
Queue that is selected in theReporting Queues box (above).

Action Buttons

TheAdd, Edit,Delete, and Auto Fix Action buttons are used to make changes to the Report Printers
setup on theMillennium System Information page. The Finished button is used to close the
Printers utility.

Printer Utility Procedures
(All procedures assume that you already launched the Printers utility from the Reporting Server
computer Queue directory.)

To add a printer to a Queue:

1. In the Printers Available for this Workstation box, select the entry for the printer that you
want to add.

2. In theReporting Queues box, select the entry for theQueue to which you want to add the
printer.

3. Click Add.

4. Type in a description for the printer.

5. ClickOK. The printer has been added to theQueue, and will be listed in the Printers Associated
with the Selected Queue box.

6. Click Finished to close the Printers utility.

To edit a Queue printer description:

1. In theReporting Queues box, select the entry for the desired Queue.

2. In the Printers Associated with the Selected Queue box, select the entry for the desired
Printer.

3. Click Edit.



Printer Utility Procedures

4. Type in a new description for the printer.

5. ClickOK. The printer description has been updated, and then new description is shown in the
Printers Associated with the Selected Queue box.

6. Click Finished to close the Printers utility.

To Delete a Queue printer:

1. In theReporting Queues box, select the entry for the desired Queue.

2. In the Printers Associated with the Selected Queue box, select the entry for the Printer that
you want to delete.

3. Click Delete.

4. On theDelete Printer confirmation dialog, click Yes. The printer has been deleted and it is not
listed in the Printers Associated with the Selected Queue box.

5. Click Finished to close the Printers utility.

Auto Fix

At times, the addition of a printer to aworkstation (by usingWindows, not by usingMillennium) causes
the network system to assign or even re-align the numbering scheme (the nomenclature) for the
location of a printer. TheAuto Fix function can be used to edit that location specification for a printer
that has already been associated with aQueue so that it can be aligned with the location currently
specified on the current workstation (as shown in the Printers Available for this Workstation list
box at the top of the current dialog form).

Theremay also be incidents where the Printers utility was launched at one Reporting Server computer,
and then used to add printers for a Queue that has been installed to a different Reporting Server
computer. If this has happened, then you cannot count on the printers' location specifications to be
correct. TheAuto Fix function of this utility can be used to fix this.

To adjust location specifications for Queue printers:

1. In theReporting Queues box, select the entry for the desired Queue.

2. Compare the printer locations in the Printers Associated with the Selected Queue box to the
printer locations in the Printers Associated with the Selected Queue box.
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a. If the printer locations are the same, a fix is not necessary.

i. Click Finished to close the Printers utility.

b. If the printer locations are different:

i. Click Auto Fix.

ii. You will be told that Auto Fix should only be run from the computer where the selected
Queue resides. If you are not on the correct computer, clickNo, click Finished to close the
Printers utility, and then launch the Printers.exe application on the correct computer.

iii. If you are on the correct computer, click Yes.

iv. The utility will adjust the location for all printers for this Queue, in accordancewith the
locations in the Printers Available for this Workstation list. The adjusted location(s) will
be shown in the Printers Associated with the Selected Queue box.

v. Click Finished to close the Printers utility.



Appendix F: Installing the Sample Database

The sample database allows you to exploremany Millennium features. You can install the sample
database only on a Database Server that does not already have the sample database installed. There
must be aminimumof 100 MB free disk space on the computer.

To install the sample database on the Database Server:

1. Back up theDatabase Server computer and yourMillenniumdatabase so that the system can be
restored if a problemoccurs.

2. Log on to theDatabase Server computer as the site administrator with administrative privileges on
the computer.

3. Log on to your database as the database administrator. For SQL Server, log on using the sa login.
For Oracle, log on using theMILLORA login.

4. Complete the installation steps outlined in documents in the directory where the installation files
were extracted:

a. For SQL Server, see the SQLmillsample Install.doc file.

b. For Oracle, see theOracle millsample Install.doc file.

5. After installing the sample database, copy the files from the \Training\Docs folder (in the
directory where the files were extracted) to the \inetpub\wwwroot\mill\docs folder. These are
the documents that support the document hyperlinks in the sample database.

6. Configure the sample database in the sameway as you configured your production database.
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The following sections describe the database changes for the current and previous version of
Millennium.

Database Changes for Version 2017.1
The following database changes weremade forMillenniumVersion 2017.1.

Table Field Type/Length Description Change

phone phnactive char(1) Y/N Added to support
update/archive function.

internetaddress intactive char(1) Y/N Added to support
update/archive function.

afo_account afoaccount_
account_
key

char(320) AFO account
key

Field length increased to
accommodate change in
Abila Fundraising Online
data.

Database Changes for Version 2016.1
Therewere no database changes for version 2016.1.

Database Changes for Version 2015.1
The following database changes weremade forMillenniumVersion 2015.1.

Table Field Type/Length Description Change

address addrinitum char(1) Initium status Add fields to
support
improved
Initium
integration.

addrindate datetime Initiumdate
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Table Field Type/Length Description Change

addrinitvr varchar(30) Initium verification
info

addrinitds char(1) Initiumdetail
status

addrlat varchar(20) Address latitude Increase field
size to 20
characters
maximum.

addrlong varchar(20) Address longitude Increase field
size to 20
characters
maximum.

contactinfo continitum char(1) Initium status Add fields to
support
improved
Initium
integration.

contindate datetime Initiumdate

continitvr varchar(30) Initium verification
info

continitds char(1) Initiumdetail
status

creditcard credinitum char(1) Initium status Add fields to
support
improved
Initium
integration.

credindate datetime Initiumdate

credinitvr varchar(30) Initium verification
info



Database Changes for Version 2015.1

Table Field Type/Length Description Change

credinitds char(1) Initiumdetail
status

speaker spkrinitum char(1) Initium status Add fields to
support
improved
Initium
integration.

spkrindate datetime Initiumdate

spkrinitvr varchar(30) Initium verification
info

spkrinitds char(1) Initiumdetail
status

event evntinitum char(1) Initium status Add fields to
support
improved
Initium
integration.

evntindate datetime Initiumdate

evntinitvr varchar(30) Initium verification
info

evntinitds char(1) Initiumdetail
status

event_guest guestinitm char(1) Initium status Add fields to
support
improved
Initium
integration.

guestindte datetime Initiumdate
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Table Field Type/Length Description Change

guestinitv varchar(30) Initium verification
info

guestinitd char(1) Initiumdetail
status

activity actvinitum char(1) Initium status Add fields to
support
improved
Initium
integration.

actvindate datetime Initiumdate

actvinitvr varchar(30) Initium verification
info

actvinitds char(1) Initiumdetail
status

zipcodes zip_lat varchar(20) Zip code latitude Increase field
size to 20
characters
maximum.

zip_long varchar(20) Zip code longitude Increase field
size to 20
characters
maximum.

institutions table_code char(8) Increase field
size to match
industry
standard.

school schlinstit char(8) Increase field
size to match
industry
standard.



Database Changes for Version 2015.1

Table Field Type/Length Description Change

afo_account afoaccountkey numeric(13,0) AFO account key Add table for
AFO integration.

afoaccount_
name

char(30) AFO account name

afoaccount_
type

numeric(5,0)

afoaccount_
id_number

char(20)

afoaccount_
account_key

char(30)

afoaccount_
active

char(1) AFO account
status (Active
check box)

afo_forms afokey numeric(13,0) AFO form key Add table for
AFO and Online
Constituent
Directory
integration.

afoname char(50) AFO form name

afoform varchar(2000) AFO form code
snippet

afoactive char(10) AFO form status

Online_Trans Online transaction
table

Add table for
AFO Connector
integration.

Online_
Signups

Online signup
table

Add table for
AFO Connector
integration.
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Table Field Type/Length Description Change

Online_Parent Online parent
table

Add table for
AFO Connector
integration.

Online_
Register

Online registration
table

Add table for
AFO Connector
integration.

Online_
PaymentCycle

Online payment
cycle table

Add table for
AFO Connector
integration.

Online_
History

Online history
table

Add table for
AFO Connector
integration.

Database Changes for Version 2014
In 2014.1, 65 columnswere added to thememories table. If you are upgrading from 2013, these
columnswill be added to the database. Depending on the number of data records in thememories
table, the database conversion programmight take longer than usual.
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